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General Help for SLIP Connection Manager

Important: Help is available at all times.    To access help from any dialog or field, simply press F1.    Help 
for push buttons can be obtained by highlighting a button and pressing F1.

To exit the SLIP Connection Manager, select the Close option on the System menu.

What is SLIP Connection Manager?

The SLIP Connection Manager (WSCM.EXE) is a WINDOWS version of the SLCONFIG utilitiy program 
for use in conjunction with the asynchronous Tcp/Ip kernel (TCPIP_SL.EXE)    that provides control of    a 
modem connection between a local PC and a remote Tcp/Ip capable system . 

Since the principles of operation found in the DOS SLCONFIG program equally apply to this WINDOWS 
version, only the enhancements are described here.    A description of SLCONFIG can be found in the 
Tcp/Ip manual and the documentation update file, KERNEL.UPD.

The client area of the main program window behaves like a terminal during certain phases of program 
execution.    All asynchronous data received on the communications port prior to the establishment of 
Tcp/Ip mode is displayed in this terminal area.    This includes data sent to the modem and result codes 
received from the modem.    In addition, when a connection has been made but Tcp/Ip mode has not been
established, any keyboard input will be transmitted to the remote system.    When this capability is 
enabled it is indicated on the terminal status line as INTERACTIVE MODE.

If a selected PHONES database file entry for a dial operation contains batch commands, they should be 
defined in the order that the sequences will occur in the receive data stream.    The dial operation is 
considered complete when the last defined sequence has been matched in the receive data stream. 

The SLIP Connection Manager can be executed for manual operation by not specifying a command line 
or can be executed automatically by specifying a command line.

Manual Execution

To initiate a manual dial operation, it is necessary to:

1. Process the communications settings dialog
2. Process the dial settings dialog
3. Select the Dial menu item from the Commands menu.

During a manual dial operation, a dialog is displayed that contains a CANCEL pushbutton and indicates 
the status of the dial process.    If the CANCEL pushbutton is selected and a connection has not been 
established, a hangup operation will be automatically performed.    If CANCEL is selected after a 
connection has been established but before any defined batch commands have been executed, the 
connection will not be broken and INTERACTIVE    MODE will be enabled.

To initiate a manual hangup operation, it is necessary to:

1. Process the communications settings dialog if the Tcp/Ip kernel is configured to support more than 
one communications port

2. Select either the Hangup menu item or the Force Hangup menu item from the Commands menu.

Automatic Execution

To initiate an automatic dial operation, the program should be executed as follows:



WSCM DIAL interface modem-entry phone

where:
interface is the name of the serial line interface sl0, sl1,    etc
modem-entry is the name of a modem.    This may be the entry number or the entry name of an item in 
the MODEMS database file.    If the entry name contains embedded spaces the name may be enclosed in
quotes within the command line.
phone is either a phone number prefixed by an at sign (@) or an entry in the PHONES database file

Examples:-
WSCM DIAL sl0 36 csannex
or
WSCM DIAL sl0 "Hayes-Compatible 9600" csannex

During an automatic dial operation, there is never the need for operator interaction.    If an error condition 
occurs, a message will be written to the file SOFT_TCP.INI in the default windows directory instead of a 
message box being displayed that would require operator intervention to dismiss that error message. 

To initiate an automatic hangup operation, the program should be executed as folloes:

WSCM HANGUP interface
or
WSCM FORCEHANGUP interface

where:
interface is the name of the serial line interface al0, al1, etc 

Batch Commands

Batch commands are defined with their associated PHONES database file entry and can be used to 
perform automatic logons to remote systems and to decode ip addresses in the receive data stream that 
are to be used by the local PC. 

Supported commands are:

SEND string[cr]
WAITFOR string SEND reply[cr]
WAITFOR_IP string
WAITFOR_NETMASK string
WAITFOR_GATEWAY string
SLIPMODE

where
[cr] is a convenient internal representation for the carriage return character (value 13). [lf] may also be 
used to represent a line feed character (value 10).

The SEND keyword defines a string that is to be transmitted to the remote system as soon as a carrier 
signal is detected during connection establishment.

The WAITFOR keyword defines a string that when detected in the receive data stream causes the 
associated SEND string to be transmitted to the remote system. 

The WAITFOR_IP, WAITFOR_NETMASK and WAITFOR_GATEWAY keywords define lead-in strings for 
the local ip address, local ip address mask or gateway ip address respectively.    When one of these lead-
in strings has been detected in the receive data stream then    the receive data stream is further monitored
for the first available ip address, in dotted notation.    When a valid ip address has been received, that 



address is subsequently used by the kernel during Tcp/Ip operations.    These lead-in strings only need to 
define a uniqe string that precedes an ip address somewhere in the receive data stream,    they do not 
have to define the string immediately preceding the ip address.

The SLIPMODE keyword causes the Tcp/Ip kernel to be put into SLIP mode and execution of batch 
commands to be terminated.    It is executed when the last    defined command has been executed.    If 
none of these keywords is defined, the SLIPMODE command is executed as soon as the carrier signal is 
detected during connection establishment.

Primary Action Bar Menus

Use the File Menu to:

1. exit SLIP connection manager

Use the Commands Menu to:

1. establish a connection to a Tcp/Ip network
2. break a connection into a Tcp/Ip network
3. enter interactive mode

Use the Settings Menu to:

1. select a device interface
2. select a modem entry from the MODEMS database file
3. set the communications port speed, data bits, parity and stop bits parameters
4. either enter a phone number to dial or select a phone number entry from the PHONES database file
5. set a timeout for a dial operation

Use the Help Menu to:

1. learn about using the Help system
2. access this Help panel
3. learn about key functions within this program
4. access the Help index



Help for File Menu

Use the File Menu to:

1. Exit SLIP Connection Manager

Exit



Exit

Select this menu item to exit the SLIP Connection Manager.

No additional processing is performed and any existing connection will remain connected.



Help for Commands Menu

Use the Commands Menu to:

1. Establish an asynchronous connection between the local PC and a remote Tcp/Ip capable system.
2. Perform an asynchronous connection hangup if that connection has no active Tcp/Ip sessions
3. Force an asynchronous connection hangup.

Dial
Hangup
Force hangup



Dial

Select this menu item to establish an asynchronous connection between the local PC and a remote Tcp/Ip
capable system.    This item is not enabled until a modem has been selected from the communications 
settings dialog and a phone number has been entered through the dial settings dialog.

If a connection already exists and there are no active Tcp/Ip sessions, a hangup will be performed before 
the connection establishment is initiated.

If a connection already exists, there are active Tcp/Ip sessions, and the number for the existing 
connection is the same is the number for the new connection, the dial operation will not need to be 
performed since a valid connection already exists..

A dialog will be displayed for the duration of the dial operation that contains a text status field indicating 
progress.    Upon completion of the dial operation, the dialog will be automatically dismissed and 
Interactive Mode will be enabled.    Any subsequent keyboard input will be sent to the remote system and 
received data will be displayed in the main window.



Hangup

Select this menu item to hangup a connection when there are no active Tcp/Ip sessions..

If the connection has active Tcp/Ip sessions, the hangup will not be performed.    Either the active 
sessions should be closed and the hangup operation repeated or the force hangup menu item should be
selected.



Force Hangup

Select this menu item to hangup a connection when there are active Tcp/Ip sessions that either can not or
do not need to be closed.



Help for Settings Menu

Use the Settings Menu to:

1. Display the communications settings dialog
2. Display the dial settings dialog

Communications Settings
Dial Settings



Communications Settings

Select this menu item to display a dialog to:

1. Select a device interface
2. Select a modem
3. Select the communications port baud rate
4. Select the communications port data bits, dtop bits and parity

Device Interface
Modem
Baud Rate
Communications Parameters



Dial Settings

Select this menu item to display a dialog to:

1. Select a number to dial
2. Specify a dial operation wait for carrier timeout
3. Specify a dial operation execute batch commands timeout

Number to DIal
Phone Numbers
Wait for Carrier Timeout
Execute Batch Commands Timeout



Help for Communications Settings

Device Interface
Modem
Baud Rate
Communications Parameters



Help for Communications Settings

Modem
Baud Rate
Communications Parameters



Device Interface

Select a device interface for a subsequent dial or hangup operation.

When the Tcp/Ip kernel supports more than one asynchronous communications port, it is necessary to 
select on which port a subsequent dial or hangup operation is to be performed.    Only those ports for 
which the kernel is configured are enabled can be selected.    This field will not appear in the 
communications settings dialog if the Tcp/Ip kernel is only configured for a single asynchronous 
communications port.



Modem

Select a modem name from the modem list.

The modem list is built from the entries in the MODEMS database file.    When a modem list entry is 
selected, the baud rate and communications parameters fields of this dialog will be updated with the data 
from that MODEMS database file entry and these fields will be enabled for selection.    These fields may 
be modified but if the change is not temporary it is recommended that the MODEMS database file entry 
be changed permanently.



Baud Rate

Select the desired communications port baud rate entry from the list of supported values.

If this field value is modified from the value set in the selected MODEMS database file entry and the 
change is not temporary, it is recommended that the MODEMS database file entry be changed 
permanently.



Data Bits, Stop Bits, Parity

Select the desired combined communications port data bits, stop bits and parity entry from the list of 
supported values.

If this field value is modified from the value set in the selected MODEMS database file entry and the 
change is not temporary, it is recommended that the MODEMS database file entry be changed 
permanently.



Help for Dial Settings

Number to Dial
Phone Numbers
Wait for Carrier Timeout
Execute Batch Commands Timeout



Number to Dial

Enter the phone number of the remote Tcp/Ip capable system in this Number to Dial field.

If the phone number is available as an entry in the Phone Numbers list, it may be selected from there.

If the number to dial is entered directly into the Number to Dial field and it is a frequently used number, it 
is recommended that this number be setup as a permanent entry in the PHONES database file.



Phone Numbers

Select the name of the entry contaiing the number to dial from this Phone Numbers list.

The Phone Numbers list is built from the entries in the PHONES database file.    When a Phone Numbers 
list entry is selected, the Number to Dial field of this dialog will be updated with the data from that 
PHONES database file entry.    This field may be modified but if the change is not temporary it is 
recommended that the PHONES database file entry be changed permanently.



Wait for Carrier Timeout

Specify the maximum time interval that a dial operation should take between the initiation of the dial 
operation and the detection of a carrier signal.

This field is allowed a value of    between 1 and 255 seconds.



Execute Batch Commands Timeout

Specify the maximum time interval that a dial operation should take between the detection of a carrier 
signal and the execution of the last batch command that specifies a receive string for the selected entry in
the PHONES database file.

This field is allowed a value of between 1 and 255 seconds.

The value of this field is ignored during a dial operation If the Number to Dial was not resolved from the 
PHONES database file Phone Numbers list entry or the selected Phone Numbers    list entry does not 
contain any batch commands.



Keys Help

For more information, select:

Action bar keys
Menu keys
Dialog keys
System keys



Action Bar Keys

Use these keys to select the System icon and action bar items,

F10
Switches between the action bar and the editing area.

Shift-Esc
Switches between the System icon and the editing area.

Right
Highlights the next action bar item or the System icon.

Left
Highlights the previous action bar item or the Ssystem icon.

Enter
Accesses the pull-down of the highlighted action bar item or System icon.

Mnemonic
The mnemonic key is the key corresponding to the underlined letter in the action bar items.    It accesses 
the pull-down of the action bar item containing the mnemonic.

Escape
Cancels the pull-down of the highlighted action bar item or System icon.



Menu Keys

Use these keys to select pull-down items.

Up
Moves up one pull-down item.

Down
Moves down one pull-down item.

Enter
Selects the highlighted pull-down item.

Mnemonic
The mnemonic key is the key corresponding to the underlined letter in the pull-down items.    It selects the 
pull-down item containing the mnemonic.

Escape
Closes the pull-down.



Dialog Keys

Use these keys to select dialog box items.

Tab
Moves to the next control group on the dialog.

Shift+Tab
Moves to the previous control group on the dialog.

Right
Moves to the next button on the dialog.

Left
Moves to the previous button on the dialog.

Up
Moves up one item in a selection box.

Down
MOves down one item in a selection box.

Page Up
Scrolls up one page in a selection box with scroll bars.

Page Down
Scrolls down one page i a selection box with scroll bars.

Spacebar
Changes a checkbox from on to off or off to on.

Enter
Starts the activity for the selected pushbutton.

Escape
Exits the dialog.



System Keys

Use these keys to switch between, move and size Presentation Manager windows.

Alt+Tab
Switches to the next Presentation Manager window.

Alt+Shift+Tab
Switches to the previous Presentation Manager window.

Alt+Esc
Swicthes to the next application (including non-Presentatin Manager applications).

Ctrl+Esc
Switches to the tak list.

Alt+F4
Closes the active window.

Alt+F5
Restores the active window.

Alt+F7
Moves the active window.

Alt+F8
Sizes the active window.

Alt+F9
Minimizes the active window.

Alt+F10
Maximizes the active window.



OK

Select OK to accept all changes made to this dialog and continue.



CANCEL

Select CANCEL to discard all changes made to this dialog and continue    The original values for each 
field will be restored.






